WHO AnthroPlus for Personal Computers Manual

Software for assessing growth of the world's children and adolescents

Let's move it baby!
WHO AnthroPlus software license agreement:


This End User License Agreement accompanies the WHO AnthroPlus software for personal computers and all related documentation. It refers to this current software version and any upgrades or modified versions of it licensed by WHO. Please read this Agreement carefully before starting the installation. By installing this software you (the User) accept all the terms and conditions of this Agreement.

The software and all related documentation are and shall at all times remain the intellectual property of the World Health Organization. Nothing contained in this Agreement shall be deemed to convey to the User any title or ownership in the software or the related documentation. The software is being made available by WHO for use in its present form for the application of the WHO Child Growth Standards and the WHO Reference 2007. With an identification of the source WHO AnthroPlus may be freely distributed and copied in whole, but not in part nor for sale or for use in conjunction with any commercial or promotional purpose.

The User is not permitted to modify, adapt, translate, reverse-engineer, decompile, disassemble, or otherwise attempt to discover the source code of the software, without prior permission from WHO. In addition, the User is not permitted to use any part of the contents of the software to develop a product that is to be sold or licensed for a fee. Users interested in developing any derived products are asked to contact: Department of Nutrition, World Health Organization, 20 Avenue Appia, 1211 Geneva 27, Switzerland (fax: +41 22 791 4156).

All reasonable precautions have been taken by the World Health Organization to verify the information contained in this software. However, the software is being distributed without warranty of any kind, either express or implied. The responsibility for the use of the software lies with the User. In no event shall the World Health Organization be liable for damages arising from its use.

(i) Suggested citation

WHO AnthroPlus
for Personal Computers

Software for assessing growth
of the world's children and adolescents

Designed and developed by

Monika Blössner
Amani Siyam
Elaine Borghi
Adelheid Onyango
Mercedes de Onis

Department of Nutrition
for Health and Development, Geneva, Switzerland

Simon Goumaz
blue-infinity, sa, Geneva, Switzerland
Acknowledgments

The software was developed with the support of blue-infinity (b-i) sa, Geneva, Switzerland. We want to acknowledge the excellent work conducted by the b-i team.

We are extremely grateful to the many individuals who helped test the new version and provided valuable feedback, in particular: Mr Amir Moez Naïmi (IT consultant, ServiceGeneva, Switzerland), Camila Corvalan University of Chile, our colleagues at WHO Geneva and from the European office in Copenhagen.

The guidance and continual technical support by Mrs Liliana Pievaroli (WHO/AME) is greatly acknowledged.

The development of this software was financed by a grant from the Bill and Melinda Gates Foundation to the Department of Nutrition.
Table of contents

WHO AnthroPlus software license agreement: .................................................................i
Acknowledgments.................................................................................................................. ii
Abbreviations........................................................................................................................ v
What is WHO AnthroPlus for personal computers............................................................ vi
Organization of this manual .............................................................................................. vii
Typographic conventions.................................................................................................. vii
1. Background and technical details on WHO standards and WHO reference........... 1
   1.1 WHO Child Growth Standards (0-5 years) ............................................................ 1
   1.2 The WHO Reference 2007 (5-19 years) ................................................................. 1
   1.3 Technical details on the software indicators ....................................................... 2
   1.4 Standard growth measurement procedures ....................................................... 2
2. WHO AnthroPlus setup ............................................................................................... 3
   2.1 Requirements .......................................................................................................... 3
   2.2 Installation ............................................................................................................. 3
   2.3 Re-installation ....................................................................................................... 4
   2.4 Configurations ....................................................................................................... 5
3. Basic software functions ............................................................................................. 5
   3.1 Icons .................................................................................................................... 5
   3.2 Data entry ............................................................................................................. 6
      3.2.1 Age ............................................................................................................ 6
      3.2.2 Oedema .................................................................................................... 8
      3.2.3 Anthropometric data ........................................................................... 8
   3.3 Results ............................................................................................................... 9
      3.3.1 Percentiles and z-scores ...................................................................... 10
      3.3.2 Colour coding ....................................................................................... 10
      3.3.3 Graphs .................................................................................................... 11
      3.3.4 BMI ........................................................................................................ 11
   3.4 Variables and codes ............................................................................................ 12
      3.4.1 Data codes .......................................................................................... 12
      3.4.2 Flags and error tracking ...................................................................... 12
4. Software modules: use and functions ..................................................................... 13
   4.1 Start window ......................................................................................................... 13
   4.2 Anthropometric calculator (AC) .......................................................................... 14
      4.2.1 Data-entry window ............................................................................. 14
      4.2.2 Graphs .................................................................................................... 15
   4.3 Individual assessment (IA) .................................................................................. 16
      4.3.1 Main window .......................................................................................... 16
      4.3.2 New child ............................................................................................... 19
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.3.3 New visit</td>
<td>23</td>
</tr>
<tr>
<td>4.3.4 Child report</td>
<td>24</td>
</tr>
<tr>
<td>4.3.5 Import from file</td>
<td>24</td>
</tr>
<tr>
<td>4.3.6 Export to file</td>
<td>24</td>
</tr>
<tr>
<td>4.4 Nutritional survey (NS)</td>
<td>25</td>
</tr>
<tr>
<td>4.4.1 Survey window</td>
<td>26</td>
</tr>
<tr>
<td>4.4.2 New record</td>
<td>29</td>
</tr>
<tr>
<td>4.4.3 A special note on age</td>
<td>29</td>
</tr>
<tr>
<td>4.4.4 Survey options</td>
<td>30</td>
</tr>
<tr>
<td>4.4.5 Flagging</td>
<td>31</td>
</tr>
<tr>
<td>4.4.6 Special spreadsheet functions</td>
<td>31</td>
</tr>
<tr>
<td>4.4.7 Results</td>
<td>32</td>
</tr>
<tr>
<td>4.4.8 Data import</td>
<td>34</td>
</tr>
<tr>
<td>4.4.9 Data export</td>
<td>37</td>
</tr>
<tr>
<td>5. Other functions</td>
<td>38</td>
</tr>
<tr>
<td>5.1 Address reference data</td>
<td>38</td>
</tr>
<tr>
<td>5.1.1 Country list</td>
<td>38</td>
</tr>
<tr>
<td>5.1.2 SALB data</td>
<td>38</td>
</tr>
<tr>
<td>Removing SALB data</td>
<td>39</td>
</tr>
<tr>
<td>5.1.3 State, Province and District list</td>
<td>40</td>
</tr>
<tr>
<td>5.2 Online help</td>
<td>40</td>
</tr>
<tr>
<td>5.3 About</td>
<td>40</td>
</tr>
<tr>
<td>5.4 Error log and error reporting</td>
<td>40</td>
</tr>
<tr>
<td>5.5 File formats</td>
<td>41</td>
</tr>
<tr>
<td>5.5.1 General rules</td>
<td>41</td>
</tr>
<tr>
<td>5.5.2 File formats</td>
<td>41</td>
</tr>
<tr>
<td>5.5.3 IA data format</td>
<td>42</td>
</tr>
<tr>
<td>5.5.4 NS data format</td>
<td>43</td>
</tr>
<tr>
<td>5.5.5 Address reference data</td>
<td>44</td>
</tr>
<tr>
<td>6. References</td>
<td>45</td>
</tr>
</tbody>
</table>
Abbreviations
The following abbreviations are used in this manual:

AC  Anthropometric calculator module
BAP  BMI-for-age percentile
BAZ  BMI-for-age z-score
BMI  Body mass index (weight in kg divided by height in metres squared)
DoB  Date of birth
DoV  Date of visit
FAO  Food and Agriculture Organization of the United Nations
HAP  Length or height-for-age percentile
HAZ  Length or height-for-age z-score
IA  Individual assessment module
ID  Identification number
MGRS  WHO Multicentre Growth Reference Study
MS  Microsoft
NA  Not available
NCHS  National Center for Health Statistics
NS  Nutritional survey module
OS  Operating system
PC  Personal computer
SALB  Second Administrative Level Boundaries
SD  Standard deviation
WAP  Weight-for-age percentile
WAZ  Weight-for-age z-score
WHO  World Health Organization
What is WHO AnthroPlus for personal computers

WHO AnthroPlus is a software for use on desktop personal computers or laptops using MS Windows. It was developed to facilitate the application of the WHO Reference 2007 for 5-19 years to monitor the growth of school-age children and adolescents. To show the continuity with the WHO Child Growth Standards for 0-5 years (see www.who.int/childgrowth) these are included in AnthroPlus for the three indicators that apply, i.e. weight-for-age, height-for-age and BMI-for-age. This software enables monitoring growth in individuals and populations of children from birth to 19 years of age.

WHO Anthro, in turn, is a software which was published in 2006 together with the first set of the WHO Child Growth Standards (i.e. weight-for-age, height-for-age, weight-for-height, BMI-for-age and windows of achievement for six gross motor milestones). In 2008 WHO Anthro was updated to include the second set of attained growth indicators: Head-circumference-for-age, arm-circumference-for-age, triceps and subscapular skinfold-for-age, and to allow users to choose a French or Spanish language version.

With the launch of the WHO Reference 2007 for children 5-19 years users expressed the need for a software to facilitate data analysis for this age group. AnthroPlus allows users to import the data previously collected in WHO Anthro and to continue monitoring children's weight, body mass index and height as they grow older (Individual assessment module) and to analyze survey data including preschool, school age children and adolescents (Nutritional survey module). Thus AnthroPlus facilitates the detection of thinness, underweight, overweight and obesity in individuals and populations from 0-19 years. In addition, it includes the option to change from the default language English to French, Spanish and Russian.

WHO AnthroPlus consists of three modules:

- **Anthropometric calculator (AC)**
- **Individual assessment (IA)**
- **Nutritional survey (NS)**

Each module has specific functions, i.e. to assess an individual's nutritional status, follow a child's growth from birth to 19 years, and conduct nutritional surveys covering the same age group, respectively.

This manual provides a brief overview of the WHO Child Growth Standards and the WHO Reference 2007 as well as instructions on how to apply them with this software. It provides guidance on software installation and management, navigation through the fields, entering data and deriving results.

WHO AnthroPlus for personal computers (PCs) mirrors the functionalities of WHO Anthro for 0-5 years with the exception that this software derives nutritional status information only for the indicators weight-for-age (up to 10 age 10 years), height-for-age and BMI-for-age. As both software are MS Windows-based, data can easily be transferred, the logical direction being that data from WHO Anthro is imported into AnthroPlus. Both software use common command icons, enabling the user familiar with the one software to easily execute the same functions in the other. Importing data from WHO Anthro into AnthroPlus is a straightforward process and exporting to common file formats is possible. WHO AnthroPlus applies the WHO Child Growth Standards for children aged 0-60 months and the WHO Reference 2007 for the older children and adolescents, i.e. 5-19 years (61-228 months).

The WHO AnthroPlus software for PC and its manual can be downloaded from www.who.int/growthref/software.

For more information, please contact:

WHO AnthroPlus  
Department of Nutrition  
World Health Organization  
Avenue Appia 20  
CH - 1211 Geneva 27  
fax: +44 22 791 4156

Or go to web site www.who.int/growthref
Organization of this manual
The first section of this manual provides background information and presents the application of the WHO child growth standards and the WHO reference 2007.

The next part describes the various software products and provides information on general installation options and technical requirements.

Given that several software features and applications are common in all modules, such as data-entry, these are outlined beforehand.

A separate section describes the specifications of the PC platform with step-by-step working examples for each of the modules.

In the last sections the user will find guidance on other functions and troubleshooting.

Typographic conventions
This manual uses the following typographic conventions:

<table>
<thead>
<tr>
<th>Item</th>
<th>Example/description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interface buttons with text</td>
<td>Click &lt;Search&gt;</td>
</tr>
<tr>
<td>Interface icon</td>
<td>Click (same as &lt;Add&gt;)</td>
</tr>
<tr>
<td>Keyboard keys</td>
<td>Press &lt;Ctrl + Alt + Delete&gt;</td>
</tr>
<tr>
<td>Menu paths</td>
<td>Click &lt; → File → Open&gt;</td>
</tr>
<tr>
<td>Interface fields/items (labels, boxes etc.)</td>
<td>Name</td>
</tr>
<tr>
<td>User input</td>
<td>Type [Jane] in the Name field</td>
</tr>
<tr>
<td>System menu paths</td>
<td>Click &lt;Start → Programs&gt;</td>
</tr>
<tr>
<td>Interface windows</td>
<td>Main</td>
</tr>
</tbody>
</table>

Whenever the manual refers to titles or names that appear on the software interface, these are printed in italics.

Important notes to users appear grey-shaded, as shown here, to be distinguished from the running text.
1. Background and technical details on WHO standards and WHO reference

1.1 WHO Child Growth Standards (0-5 years)

In 1990 the WHO constituted a Working Group on Infant Growth to develop recommendations for appropriate uses and interpretation of anthropometry in infants and young children. The Working Group’s report (WHO, 1994) led to the conclusion that the National Center for Health Statistics (NCHS)/WHO international reference was flawed and failed to depict physiologic growth adequately. Its scientific weaknesses were sufficient to interfere with the sound nutritional management of young children, and the Working Group concluded that new growth curves were needed.

Consequently the WHO Multicentre Growth Reference Study (MGRS) was implemented to provide data to construct growth curves from birth to 5 years of age (de Onis et al., 2004a). A key characteristic of the new standard is that it makes breastfeeding the biological "norm" and establishes the breastfed infant as the normative growth model. Health policies and public support for breastfeeding should thus be strengthened by having breastfed infants as the reference for normal growth and development.

The pooled sample from the six countries (Brazil, Ghana, India, Norway, Oman and the USA) that participated in the MGRS allowed the development of a truly international standard, reiterating the fact that children grow similarly when their health and care needs are met.

The wealth of data collected allowed the replacement of the international NCHS/WHO references on attained growth (weight-for-age, length/height-for-age, and weight-for-length/height) and the development of new standards for body mass index (BMI)-for-age, head circumference-for-age, arm circumference-for-age, triceps skinfold-for-age and subscapular skinfold-for-age. In addition, the accompanying windows of achievement for six gross motor development milestones provide a unique link between a child's physical growth and motor development.

Detailed descriptions of how the MGRS was implemented and the WHO Child Growth Standards were constructed are available elsewhere (de Onis et al., 2004b; de Onis et al., 2006, WHO, 2006).

In the AnthroPlus software three of the child growth standards are included (i.e. weight-for-age, length/height-for-age, and BMI-for-age). These three are the same indicators for which the WHO reference has been developed, enabling continuity in growth monitoring throughout childhood and adolescence.

1.2 The WHO Reference 2007 (5-19 years)

Previously WHO recommended the National Center for Health Statistics (NCHS)/WHO international reference for assessing growth in children and adolescents above 5 years of age. However this reference had several drawbacks: The BMI reference data starts only at 9 years of age and has a limited percentile range, 5th-95th. In addition the NCHS reference curves were constructed using a different (by now outdated) method compared to what was used for the WHO standards.

Given that the NCHS sample of 1977 included children who had reached their full height potential while not yet being overweight, it was considered as a valid approach to use these data, conduct data cleaning, i.e. identifying outliers and excluding those. The NCHS data were merged with the records of the 18-71 year-olds of the WHO standards sample and this new data set was used to derive a new reference by applying state-of-the-art growth curve construction methods (de Onis et al, 2007).

The WHO Reference 2007 provides a smooth transition from the child growth standards for 0-5 years to the older age group. The data tables and charts cover the 1st to the 99th percentile and from -3 to +3 standard deviations (SD).

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Age ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Height-for-age</td>
<td>5-19 years</td>
</tr>
<tr>
<td>Weight-for-age</td>
<td>5-10 years</td>
</tr>
<tr>
<td>BMI-for-age</td>
<td>5-19 years</td>
</tr>
</tbody>
</table>
The weight-for-age curves enables countries that routinely measure only weight to monitor growth throughout childhood. In older children, i.e. above 10 years, weight-for-age is not a good indicator as it cannot distinguish between height and body mass in an age period where many children are experiencing the pubertal growth spurt and may appear as having excess weight (by weight-for-age) when in fact they are just tall. BMI-for-age is the recommended indicator for assessing thinness, overweight and obesity in children 10-19 years.

1.3 Technical details on indicators in the software

For each indicator there are separate tables and charts for boys and girls and the user can choose between the z-score and percentile classification system.

The age ranges for each indicator are:

<table>
<thead>
<tr>
<th>Indicators</th>
<th>Age ranges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight-for-age</td>
<td>0-120 completed months</td>
</tr>
<tr>
<td>Length/height-for-age</td>
<td>0-228 completed months</td>
</tr>
<tr>
<td>BMI-for-age</td>
<td></td>
</tr>
</tbody>
</table>

For all standards involving length or height measurements, recumbent length should be used for children younger than 24 months and standing height, for children 24 months and older. The software provides a tick box, alongside the child's length or height data, to specify whether the measurement was taken in recumbent or standing position. **This information is mandatory for all children 0-60 months.** The software will automatically convert height to length for a child younger than 24 months whose height has been measured instead of length, and length to height for a child aged 24 months or older whose length was measured instead of height. The length-height conversion is not done for children above 60 months of age.

The standards' data tables (0-5 years) for all age-based indicators are in days and the reference data tables (5-19 years) in months. The tables and charts of the WHO Child Growth Standards are accessible in electronic format at [www.who.int/childgrowth/standards/en](http://www.who.int/childgrowth/standards/en); and the tables and charts of the WHO Reference 2007 can be found at [www.who.int/growthref](http://www.who.int/growthref). Detailed descriptions of the technical aspects of the WHO standards has been published (de Onis et al., 2006; WHO, 2006; WHO, 2007), as well as a paper on the WHO Reference 2007 (de Onis et al., 2007). All documents and articles can be downloaded from the respective web sites.

1.4 Standard growth measurement procedures

Before applying the WHO growth standards or the WHO reference 2007 it is important to follow standardized measurement procedures in order to collect reliable data. Detailed measuring protocols can be found in:


2) World Health Organization. Training Course on Child Growth Assessment ([http://www.who.int/childgrowth/training/en](http://www.who.int/childgrowth/training/en)).

Among the most important points to ensure the collection of accurate anthropometric data are:

- Make sure all equipment is correctly calibrated on a regular basis.
- Conduct training based on recommended measurement protocols as well as standardization sessions for those who collect the data.
- Take the child's date of birth from a written record if available. Otherwise ask for both the child's date of birth and age on the day measured, since the year of birth is frequently reported incorrectly. If birth dates are not recorded or known with certainty, probe the caregiver for the approximate date of birth based on a local events calendar.
• Measure recumbent length in children younger than 24 months of age and standing height from 24 months onwards. In case this cannot be adhered to because, e.g. a child is too sick to stand, the software is designed to automatically convert the measurement.
• Always enter the information on whether recumbent length or standing height was measured.
• Children who can stand up and are willing to stand should be measured standing whereas children who cannot stand up or are too weak to do so should be measured in recumbent position.
• Always indicate if the child has oedema or not.
• After the age, sex, weight, and length/height information have been entered, the user should check the results by using the graphing option to view single and multiple measurements. If a child appears to have extreme values beyond the flag boundaries s/he should be re-measured immediately.

2. WHO AnthroPlus setup

2.1 Requirements

The WHO AnthroPlus software is meant to be applied by a wide range of users, including people with limited software handling knowledge. Therefore this section is intentionally as non-technical as possible. It presents the minimum information necessary for the user concerning requirements, installation of the software and the default configurations.

Before the application can be installed, the PC or laptop must have the following Operating System (OS) and software pre-installed:

• The .NET 2.0 runtime (22.4 Mb)

To check installed version of Windows:

• Go to Start → Control Panel → System → General

If the necessary OS is missing, please contact your IT Support.

To check if the .NET 2.0 runtime is installed:

• Go to Start → Control Panel → Add or Remove Programs, then verify if ‘Microsoft .NET Framework 2.0’ is listed under Currently installed programs (e.g. Windows Vista comes with .NET 2.0 pre-installed)

If .NET Framework 2.0 is missing, go the following link to download it:


Minimum available disk space needed is around 6 Mb (for the application itself), plus sufficient additional disk space for Windows to function properly. Please note that the application size on disk (i.e. database size) will grow proportionally to the amount of data manipulated in the application (and thus stored in the database). To check available space on the hard drive:

• Right click on the hard drive (usually it’s the C drive), then select Properties → General

2.2 Installation

The user may choose either to download the software from the WHO Reference 2007 web site www.who.int/growthref/tools/en or to install it from a CD-ROM.

The WHO Anthro and the present WHO AnthroPlus are two independent software applications. Users may choose to install only one of them or operate both in parallel.
To install the application:

- Run *WHO AnthroPlus setup.exe* and follow the instructions on the screen

To run the application, do either of the following:

- On your desktop, double-click the WHO AnthroPlus icon, or
- In *Start → Programs → WHO → WHO AnthroPlus*

**Program files**

When you open the folder WHO AnthroPlus it should contain 16 program files and 4 folders (see image to the right).

![Program files screenshot](image)

### 2.3 Re-installation

If the software is re-installed (with the same or a new version), note that AnthroPlus will keep intact the database file *WHOAnthroPlus.sdf*. If for some reason, users want to remove the software before re-installing then they are advised to first copy the database file *WHOAnthroPlus.sdf* to a safe location before un-installing WHO AnthroPlus.

To un-install:

- In *Add or Remove Programs* (from the Windows control panel), find WHO AnthroPlus and choose *Remove* (confirm when prompted to)

WHO AnthroPlus has another component that should not be removed in case other installed software uses the same:

- Microsoft .NET 2.0 Compact Framework (note that for example, Windows Vista comes with .NET 2.0 pre-installed)

To re-install:

- Follow installation instructions
2.4 Configurations

The date format in WHO AnthroPlus is automatically set to match the user’s date format as selected on the PC set-up functions. The user interface screens are fixed in size and colours, and cannot be altered.

Changing the language can only be done from inside the Application menu.

To change from the default language (English) to French, Russian or Spanish, the user has to change the regional settings by clicking:

Application ➔ Settings

Click on drop-down menu <▼> and select the preferred language.

Click <Save> and then <OK> button in the message window "The application must be restarted for all the new settings to take effect."

Close the program by clicking on [X] or the corresponding icon and then restart WHO AnthroPlus.

When French, Russian or Spanish language have been selected but the operating system language of the PC is English, the buttons on message boxes will still read, e.g. <OK> and <Cancel>. This behaviour is standard in .Net.

Note that the software by default runs in English (independent of the OS language). Users have to manually select the preferred alternative language. Once selected the language remains set until it is changed again in Settings.

There are other default enhancements concerning the user interface and performance:

- ‘Enter key’ enabled to facilitate moving easily from one data-entry field to the next
- Mouse wheel disabled to avoid accidental changes on numeric up/down controls when entering measurements
- Reference data tables are automatically cached in memory to improve application performance

To produce an output, e.g. report of results, the application looks for Excel and uses it if present; if not, the software opens the default program set by the user for reading TXT files.

Data from the IA and NS modules are saved to the database file WHOAnthroPlus.SDF.

Note: If the database file has become corrupted, the application will notify that there is a problem connecting to the database. In that case the software needs to be reinstalled.

3. Basic software functions

The following section outlines the module functions that are similar throughout the software.

3.1 Icons

WHO AnthroPlus uses the following command icons with consistent functions:
### 3.2 Data entry

The child's age, weight, oedema status (yes/no), length/height and type of measurement (recumbent or standing) for 0-60 months are the basic variables required to derive the nutritional status in terms of weight-for-age, height-for-age and BMI-for-age. For children 61 months and older the "type of measurement" information is not required, hence the box appears greyed out. Tab and Enter keys as well as the mouse-click allow the user to move from one field to the next.

#### 3.2.1 Age

The software uses date of birth (DoB) and date of visit (DoV) to derive and display age in years and completed months (total completed months in parenthesis). The user is advised to double check this derived age with the caregiver to confirm that it is correct.

Age in days is derived using the formula: Number of months × 30.4375. For example age in days at 24 months is: \(24 \times 30.4375 = 730.5\) (rounded to 731 days).

In order to account for leap years, age in completed months is calculated on the principle that one year has 365.25 days, and thus one month (365.25 divided by 12 [months]) is equal to 30.4375 days. Therefore, a child born 11 November 2007 and measured 11 November 2008 appears as having an age of 11 completed months (365 divided by 30.4375 equals 11.99).

Given that the WHO standards are in units of days and WHO reference tables are in months, the age information is derived accordingly. If a child is between 0 and 60 months old, the nutritional status indicators are derived using the child's exact age in days in order to refer to the WHO standards tables.
If a child is 61 months and older the software derives the age in months with decimals and refers to the WHO reference tables, where a precise z-score is derived by interpolation.

DoV is by default set to the current system (today’s) date and DoB to the same date of the previous year.

The user is asked to enter the child’s exact date of birth (DoB). The date can be entered either by typing it in or selecting a date via the calendar window (see image below). To open the calendar, click on ↔ on the right side of the date field.

The calendar has multiple modes of selecting dates.

<table>
<thead>
<tr>
<th>October 2007</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mon</td>
</tr>
<tr>
<td>24</td>
</tr>
<tr>
<td>1</td>
</tr>
<tr>
<td>8</td>
</tr>
<tr>
<td>15</td>
</tr>
<tr>
<td>22</td>
</tr>
<tr>
<td>29</td>
</tr>
</tbody>
</table>

Today: 25/10/2007

Clicking on a date within the open month.

Clicking on the Today text will automatically shift the calendar and selected date to the current system date.

Clicking on the ↔=Previous month or ↑=Next month buttons changes the display one month at a time in the direction selected.

Clicking on the month opens a list with all months in the year from where the user can select again by clicking on the name of the chosen month.

Clicking on the year, e.g. <2008> opens scroll buttons that facilitate scrolling the year forward and backward.

To apply the WHO standards for 0-5 years the software uses DoB and DoV to calculate the precise age in days:

\[
\text{Age (in days)} = \text{DoV - DoB}
\]

The reason for deriving age in days is that all age-based indicator tables of the WHO Child Growth Standards are by units of days.

For the older children 5-19 years the reference tables are in completed months (see www.who.int/growthref) but the software derives the exact z-scores based on interpolation using the LMS values (see notes on “Computation of centiles and z-scores” for each indicator on the web site http://www.who.int/growthref/).

To apply the WHO reference 2007 for 5-19 years, the software uses DoB and DoV to calculate the age in months.

\[
\text{Age (in months)} = \text{DoV - DoB}
\]

The software was specifically designed to enhance the quality of age estimation. If the exact day of birth is unknown, the user should fill in the year and month of birth and tick the box next to "Approximate date". When that field is ticked, the software attributes a random day to complete the date of birth. This date is then used to derive an exact age in months.

The child’s age is an important piece of information and the observers collecting the data should probe the child’s caregiver to obtain at least an approximated date of birth (i.e. year and month). A useful tool to obtain an approximate DoB is a local events calendar. For example, Annex 1 of the FAO field manual (FAO, 1990) provides information on how to develop such a local calendar.

Note: When importing a child record with age being 24 months the software will derive 731 days and not 730.5.

The exact age is used for obtaining z-scores and percentiles and is stored in the Individual assessment (IA) and Nutritional survey (NS) modules.

For children less than 61 months (1857 days), the child’s age influences how the software handles the variables Length/Height and Measured. For example, if a child is 24-60 months old (731-1856 days) and has a length measurement, 0.7 cm is subtracted to derive an estimated height. Similarly, if a child is younger than 24 months and is measured standing, the software adds 0.7 cm to derive an estimated length.
3.2.2 Oedema

Children with oedema have swollen limbs and may look well fed. Oedema, however, is a clinical sign of severe undernutrition. Ideally, any suspected oedema case should be assessed before measuring the child's weight.

To determine whether oedema is present, grasp the child's foot so that it rests in your hands with your thumb on top of the foot. Press the thumb down gently for a few seconds. The child has oedema if a pit (dent) remains in the foot after lifting your thumb. If the child has oedema of both feet, fluid retention increases the child's weight, masking what may actually be very low weight. In case the child has oedema the user should tick the respective box in the data-entry window. Consequently no weight measurement needs to be taken as it will be flawed. In case the user measures the child's weight and ticks the "Yes" button for oedema, the software discards the weight value for such a child and computes the z-scores and percentiles for length/height-for-age only. In deriving prevalences at population level, however, a child with oedema has to be counted as below <-3 SD for all weight-related indicators. This logic is followed in all analysis options in the Nutritional survey module.

The default status for the data-entry window in all modules is that a new child has "No" oedema. If the child has oedema the user has to click the respective radio button.

3.2.3 Anthropometric data

Detailed procedures for measuring anthropometry can be found in the anthropometric training video and in the module, Measuring a Child's Growth, of the WHO child growth assessment course (available at www.who.int/childgrowth/training). It is recommended that those responsible for measuring anthropometry use these resources or be trained to take reliable measurements.

To enhance validity at data-entry and data-import, the software is programmed to accept the following measurement ranges (inclusive for minimum and maximum limits). Should the user enter a value outside those ranges, the entry field returns to blank.

<table>
<thead>
<tr>
<th>Measurement</th>
<th>Min</th>
<th>Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight (kg)</td>
<td>0.9</td>
<td>275.0</td>
</tr>
<tr>
<td>Length/height (cm)</td>
<td>38.0</td>
<td>230.0</td>
</tr>
</tbody>
</table>

Weight

Measurements should be entered in kilograms with maximum 2 decimals.

Recumbent length and standing height

Length and height measurements should be entered in centimetres with maximum 2 decimals.

In line with standard measurement procedures, the software derives for children younger than 24 months length-based indicators, and for children 24 months and older height-based indicators. There exist settings and scenarios, however, where it is not possible to comply with this recommendation and a child older than 24 months has to be measured lying down — for example when a child is too sick and too weak to stand, or when, because of time/equipment constraints, it is only possible to measure all children lying down. In these instances the software makes the necessary adjustment by subtracting 0.7 cm from the child's length to derive an estimated height. Similarly, if a child is measured standing when s/he should be measured in the recumbent position, given his/her age, the software adds 0.7 cm to derive an estimated length. The 0.7 cm difference between length and height is based on the analysis of the MGRS sample of children (18-30 months of age) who had both length and height measurements taken.

Note: This conversion applies only to children 0-60 months. If a child belongs to that age group the user must always specify and tick the appropriate button, indicating how the child was measured, i.e. in recumbent or standing position.

When interpreting the results, the following should be kept in mind: The software converts the length/height measurement for children 0-60 months to conform to the foregoing recommendation and uses that converted value for deriving all relevant indicator results (including BMI, see 3.3.4). The software interface always shows the corresponding indicator name, i.e. length-for-age for all children younger than 2 years (or up to 730 days, inclusive) and height-for-age for all children 2 years and
older (731 days or more). Therefore for a child that was measured lying down but is older than 2 years, the indicators will read: Weight-for-height and height-for-age; and the BMI as well as the BMI-for-age z-score are derived based on the height converted from length.

If neither age nor type of measurement is known, the software considers any measurement below 87 cm as length and any measurement 87 cm and above as height. The cut-off point of 87 cm reflects the standards' median of boys' and girls' length and height at 24 months. According to the WHO standards the median height is 87.1 cm for boys and 85.7 cm for girls, and the median length is 87.8 cm for boys and 86.4 cm for girls. The mean of these four values is 86.75 cm.

Depending on the child's age the software applies either the WHO standards or the WHO reference; if age is unknown only the BMI value is calculated.

For boys and girls ≥61 months the software uses the WHO Reference. Given that all children 5-19 years should be measured standing, no distinction has to be made how the child was measured.

For children 0-60 months it is important to specify how the child was measured, i.e. recumbent or standing. According to that information and the child's age the calculation is adjusted if necessary.

<table>
<thead>
<tr>
<th>Length/height-for-age</th>
<th>Sex</th>
<th>Age group (months)</th>
<th>Type of measurement (l/h)</th>
<th>Conversion</th>
<th>Data tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boys and girls</td>
<td>&lt;24</td>
<td>l</td>
<td></td>
<td></td>
<td>Length-for-age</td>
</tr>
<tr>
<td></td>
<td>&lt;24</td>
<td>h</td>
<td>h + 0.7 cm</td>
<td></td>
<td>Length-for-age</td>
</tr>
<tr>
<td>≥24 &amp; &lt;61</td>
<td>l</td>
<td>l – 0.7 cm</td>
<td></td>
<td></td>
<td>Height-for-age</td>
</tr>
<tr>
<td>≥24 &amp; &lt;61</td>
<td>h</td>
<td></td>
<td></td>
<td></td>
<td>Height-for-age</td>
</tr>
</tbody>
</table>

1 l = length; h = height

When age is known but not the type of measurement:

<table>
<thead>
<tr>
<th>Sex</th>
<th>Age group (months)</th>
<th>Data tables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Boys and girls</td>
<td>&lt;24</td>
<td>Length-for-age</td>
</tr>
<tr>
<td>≥24 &amp; &lt;61</td>
<td>Height-for-age</td>
<td></td>
</tr>
</tbody>
</table>

### 3.3 Results

All software modules enable the user to derive nutritional status information (in z-scores and percentiles) for the following indicators based on the WHO standards for preschool children and based on the WHO reference for the older children (see Table below).

<table>
<thead>
<tr>
<th>Indicators</th>
<th>WHO standards</th>
<th>WHO reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Length/height-for-age</td>
<td>0-60 months</td>
<td>61-228 months</td>
</tr>
<tr>
<td>Weight-for-age</td>
<td>0-60 months</td>
<td>61-120 months</td>
</tr>
<tr>
<td>BMI-for-age</td>
<td>0-60 months</td>
<td>61-228 months</td>
</tr>
</tbody>
</table>

For details on how to interpret each of the nutritional status indicators, users are referred to the WHO training course on Child Growth Assessment, Module C: Interpreting Growth Indicators ([www.who.int/childgrowth/training](http://www.who.int/childgrowth/training)) for children 0-60 months of age. For older children the interpretation of height-for-age and weight-for-age is as for children 0-60 months, however, for BMI-for-age the recommended cut-offs for overweight and obesity are not the same as in preschool children. For children 5-19 years the +1 SD in the WHO reference (equivalent to the 85th percentile) coincides at 19 years with the adults cut-off of BMI = 25 [kg/m²], which is the cut-off for overweight. Similarly, the +2 SD (equivalent to the 97th centile) coincides at 19 years with the adults cut-off of
BMI = 30 [kg/m²], which is the recommended cut-off for obesity. Consequently the +3 SD cut-off will be considered severely obese (corresponding to a BMI of above 35 [kg/m²]). For thinness and severe thinness the cut-offs are -2 and -3 SD, respectively.

3.3.1 Percentiles and z-scores

The default classification system used to present child nutritional status is that of z-scores or standard deviation (SD) scores. This classification system has been recommended by WHO for its capability to describe nutritional status including at the extreme ends of the distribution and allow derivation of summary statistics, i.e. means and SDs of z-scores (WHO, 1995).

Given their widespread use in clinical settings the software also derives percentiles. The percentiles are based on exact z-scores, with all decimal points. Therefore, using the displayed z-score value (rounded to 2 decimals) to hand-calculate the percentile might yield a slightly different result from that displayed by the software.

Z-scores and percentiles are derived using the exact age in days for the WHO standards and months for the WHO reference 2007. For the latter even though the reference tables are in completed months the software uses an interpolation to derive the nutritional status for the exact age in months.

The z-scores appear as not available (NA) when:
- child’s age is above 120 completed months, consequently weight-for-age is NA
- child’s age is above 228 completed months, consequently all indicators are NA
- child’s age is unknown, consequently WAZ, HAZ and BAZ are NA

Please note that percentiles read "NA" for all z-score values <-3 SD and >+3 SD because percentiles beyond ±3 SD (equivalent respectively to the 0.135th and 99.865th percentiles) are invariant to changes in respective z-scores.

In the NS module if age is missing or unknown the software derives only the BMI value.

If Weight is missing, the software can derive only HAZ and HAP; while WAZ, WAP, BAZ, BAP and BMI cannot be calculated.

If Length/Height is missing, the software derives only WAZ and WAP; while HAZ, HAP, BAZ, BAP and BMI cannot be calculated.

If a child has oedema the software derives only HAZ and HAP; while WAZ, WAP, BAZ, BAP and BMI are not calculated.

3.3.2 Colour coding

The following colour codes are applied to visually distinguish the different levels of severity:

<table>
<thead>
<tr>
<th>Colour</th>
<th>Applied to</th>
<th>z-scores (z)</th>
<th>Percentiles</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>numeric range</td>
<td>-1 SD ≤ z ≤ +1 SD</td>
<td>50th percentile</td>
</tr>
<tr>
<td></td>
<td>graph line</td>
<td>Median</td>
<td></td>
</tr>
<tr>
<td>Gold</td>
<td>numeric range</td>
<td>-2 SD ≤ z &lt; -1 SD; or +1 SD &lt; z ≤ +2 SD</td>
<td>15th and 85th percentiles</td>
</tr>
<tr>
<td></td>
<td>graph line</td>
<td>-1 SD and +1 SD</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>numeric range</td>
<td>-3 SD ≤ z &lt; -2 SD; or +2 SD &lt; z ≤ +3 SD</td>
<td>3rd and 97th percentiles</td>
</tr>
<tr>
<td></td>
<td>graph line</td>
<td>-2 SD and +2 SD</td>
<td></td>
</tr>
<tr>
<td>Black</td>
<td>numeric range</td>
<td>z &lt; -3 SD; z &gt; +3 SD</td>
<td>NA*</td>
</tr>
<tr>
<td></td>
<td>graph line</td>
<td>-3 SD and +3 SD</td>
<td></td>
</tr>
</tbody>
</table>

* NA = not available
3.3.3 Graphs

Graphing results enables the user to visualize the child’s growth. For this purpose the 0-60 months WHO standards curves and the reference curves for 5-19 years are joined together. This display feature provides a means to visually assess the growth pattern over time and to share the results with the child’s caregiver. In view of the likely continuation of using paper charts, the graphing option allows the user to check that the plot on paper is correct and corresponds with the display on the computer screen.

It is recommended to always maximize the graph window by clicking on (or corresponding icon in your MS version) to take full advantage of this viewing feature. This will also avoid that some text appears truncated.

The user can view the graph for each indicator using either the z-score or percentile classification system.

- Weight-for-age from birth to 10 years (0-120 completed months as shown on the x-axis)
- Adjacent length-for-age and height-for-age from birth to 19 years (0-228 completed months as shown on the x-axis) with a vertical line at 24 months (2 years) of age to mark the separation of length and height
- Adjacent length- and height-based BMI-for-age from birth to 19 years (0-228 completed months as shown on the x-axis) with a vertical line at 24 months (2 years) of age to mark the separation of length and height

Note that measurements corresponding to missing z-score values, presented as "NA", are not plotted.

The cut-off classification lines presented on the charts are:

- Weight-for-age: -3 SD, -2 SD, +2 SD and +3 SD
- Length/height-for-age: -3 SD, -2 SD, +2 SD and +3 SD
- BMI-for-age: -3 SD, -2 SD, -1 SD, +1 SD, +2 SD and +3 SD

In the percentile classification system charts for all indicators present the following classification lines: 3rd, 15th, 50th, 85th and 97th percentiles.

Even though percentile values smaller than 0.135th and beyond 99.865th (equivalent to -3.00 and +3.00 SD respectively) read "NA" in the results window, the corresponding anthropometric measurements are plotted as long as they fall within the limits of kg and cm represented in the respective graphs.

3.3.4 BMI

When weight and length/height measurements have been entered the software derives the BMI (kg/m²). This index has been added to the other indicators of nutritional status as it is commonly used to assess nutritional status in adults. Similar to BMI-for-age, BMI values are derived based on length for children younger than 2 years, and on height for children 2 years and older. If a child younger than 2 years has been measured standing — the standard procedure is to measure in recumbent position — 0.7 cm is added to the child’s height and the converted length is used to calculate the BMI. In case a child aged 2 years or older has length measured, 0.7 cm is subtracted to convert it to a height measurement before the BMI is derived. In case the age of the child is unknown the measurement in cm given is used without any conversion to derive the BMI value. A BMI value based on kg/m² has to be distinguished from the BMI-for-age z-score value which is based on the WHO standards or the WHO reference depending on the child’s age.

Note that for BMI-for-age the recommended cut-offs for overweight and obesity are not the same as in preschool children. For children 5-19 years the +1 SD in the WHO reference (equivalent to the 85th percentile) coincides at 19 years with the adults cut-off of BMI = 25 [kg/m²], which is the cut-off for overweight. Similarly, the +2 SD (equivalent to the 97th centile) coincides at 19 years with the adults cut-off of BMI = 30 [kg/m²], which is the recommended cut-off for obesity. Consequently the +3 SD cut-off will be considered severely obese (corresponding to a BMI of above 35 [kg/m²]). For thinness and severe thinness the cut-offs are -2 and -3 SD, respectively.
In the window for parents’ data, the user has the option to collect the adults' weight and height data to derive their BMI. This information can be useful in the interpretation of the child's nutritional status. For details on the measurements and the interpretation of BMI in adults, users are referred to the relevant WHO publications (WHO, 1995; WHO, 2003).

3.4 Variables and codes

3.4.1 Data codes

Complete lists of data formats and variable codes for the different file formats in IA and NS module are presented in 5.5.3 and 5.5.4.

3.4.2 Flags and error tracking

The software uses default lower and upper SD boundaries as flag limits to identify any extreme or potentially incorrect z-score values. The tables below list the default flag limits by indicator for the WHO standards and the WHO reference:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>WHO standards (0-60 months):</th>
<th></th>
<th></th>
<th>WHO reference (61 months-19 years):</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Lower SD</td>
<td>Upper SD</td>
<td></td>
<td>Lower SD</td>
<td>Upper SD</td>
<td></td>
</tr>
<tr>
<td>WAZ</td>
<td>-6</td>
<td>+5</td>
<td></td>
<td>-6</td>
<td>+5</td>
<td></td>
</tr>
<tr>
<td>HAZ</td>
<td>-6</td>
<td>+6</td>
<td></td>
<td>-6</td>
<td>+6</td>
<td></td>
</tr>
<tr>
<td>BAZ</td>
<td>-5</td>
<td>+5</td>
<td></td>
<td>-5</td>
<td>+5</td>
<td></td>
</tr>
</tbody>
</table>

In the AC and IA modules, users should check the results against these limits. A black background colour alerts the user if a resulting z-score is beyond -3 or +3 SD which is plausible but reflects extreme nutritional status. SD values beyond any of the corresponding limits shown above are considered implausible and the user is encouraged to check for data-entry errors.

In the NS module where data-entry can happen very fast and under strenuous conditions, any resulting z-score beyond these limits is automatically flagged and the flag code appears in the column next to the results. When that happens, the user should immediately check if there is a data-entry error and if that's not the case, re-measure the child.

In the analysis of nutritional survey data, all flagged z-scores should be excluded. The report options in WHO AnthroPlus are thus programmed to exclude any z-score value beyond these flag limits. However, flagged z-scores remain available when the data are exported. Thus, users who export the data into a different software for analysis should apply the same flag limits as exclusion criteria in order to obtain consistent results.
4. Software modules: use and functions

To open the WHO AnthroPlus Start window either double-click on the icon created on the desktop in the installation process or go to:

Start → All Programs → WHO → WHO AnthroPlus

4.1 Start window

From the start window the user can open the three modules: Anthropometric calculator (AC), Individual assessment (IA), Nutritional survey (NS).

To open a module use tab or arrow keys to select the respective button name and press <Enter>, or point with the mouse on the name and left click.

Another possibility is to click on Application and select a module.

The menu icons on the top right work as in any other MS application, to minimize and close the application. Resizing to fill the screen is not possible.

Menu options

The menu under Application enables the user to open the Settings window which consists of two tab-sections:

1) Application settings: To choose the language and to change default configurations (see 2.4)

2) Address settings to facilitate the collection of address data:

- Do not use existing address reference data, i.e. manually key in all information
- Use available UN Second Administrative Level Boundary files (SALB) (see http://www.who.int/whosis/database/gis/salb/salb_home.htm)
- Use lists for country, state, province, district, as specified by the user.

Selection can be turned on or off on this page by ticking or un-ticking the respective radio button on the upper part of the window. According to the choice made the selections appear active or inactive (grey). For example, the image above shows that SALB is active (which is linked to country list) while State, Province and District lists are grey and thus inactive.

The use of address reference data is outlined in section 5.1.
4.2 Anthropometric calculator (AC)

This module facilitates deriving nutritional status results for an individual child or adolescent based on the WHO standards (0-5 years) or WHO reference (5-19 years) depending on his/her age for the indicators weight-for-age, length/height-for-age and BMI-for-age. Results are presented in z-scores and percentiles and include the BMI unrelated to age derived by dividing weight in kg by height in meters squared. The user can view, print and copy the plotted measurements in relation to the standards and reference curves. In this graphing feature the user can switch between using the z-score and percentile classification system. In this module, the user cannot save any data. In order to keep a copy of the data-entry window, press jointly the <ALT+ Print Screen> keys and paste the image into e.g. a MS Word file. Users who would like to save the data should use the Individual assessment module.

4.2.1 Data-entry window

To open the module click on the button or select the AC from the application menu.

The module consists of one window which serves to enter the data and view the results.

To enter data and move from one field to the next one can use the keyboard and press the <Tab> (<Shift + Tab> to go back) or <Enter> keys, or else use the mouse to point the cursor on an empty field and left mouse click to activate the field.

The displayed anchor values correspond to a healthy child of 6 years. To enter any new data either overwrite the anchor values or use the scroll up/down buttons to select the exact measurement in kg or cm. The maximum level of precision for any measurement is 2 decimal places.
If the year and month of birth are known but it is impossible to obtain the exact day of birth, the observer is advised to tick the box *Approximate date*. The program then randomly selects a day within the given month and year.

If the year and month of birth are not known the observer is advised to use a local events calendar to identify two events between which the birth took place (see 3.2.1) and thus estimate an approximate month and year of birth.

Always specify the child’s sex and if s/he has oedema. The default selection is set to female and No oedema. The radio button to specify how length/height was measured is only active and can be changed for children between 0-60 completed months. For older children the selection is inactive and greyed out.

The *Results* are displayed for the percentile and the z-score classification system based on the WHO standards for 0-60 months and on the WHO reference for 61 months to 19 years. A slider control gives the percentile position of the measurement within the range 0-100%, and to the right of each slider image the corresponding percentile value is displayed rounded to one decimal. The next column presents the respective z-score value with two decimals.

**4.2.2 Graphs**

Clicking on next to the z-score result opens a plot of the respective measurement compared to the curves of the WHO standards (0-60 months) and WHO reference (61 months-19 years).

Click on (or corresponding icon) to maximize window.

The result (z-score or percentile) is displayed in the top left corner of the plot area.

On top of the graph the user is reminded that these curves depict the WHO standards for 0-60 months and the WHO reference for older children.

If a measurement cannot be plotted the message (No data) appears on a blank screen. This happens when a measurement is outside the plotting range (but possibly valid z-score), or if a z-score is NA due to missing data or the raw data are beyond the standard/reference tables' ranges (see section 1.3).

To close the graph click on at the top right corner or the corresponding icon of your MS version.

From any open graph the user can select all the other graphs (see image with open drop-down list).

This drop-down menu allows users to switch from the default z-score classification to the percentile system.

Additionally, with the left mouse click the user can select and enlarge a part of the graph. This zoom-in function can also be repeated to select an even more detailed section. To resize the graph to the original dimensions, click on .
4.3 Individual assessment (IA)
This module enables the user to collect and save data for children who are repeatedly examined up to the age of 19 years. The child's nutritional status can be derived and graphically displayed based on the WHO standards (for 0-5 year olds) and the WHO reference (for 5-19 year olds), using the z-score and percentile classification system for the three indicators weight-for-age, height-for-age and BMI-for-age. The graphing feature in this module offers views of single or multiple visits. This function helps to visualize trends in child growth. This module is particularly useful for paediatricians who want to monitor the growth of children and adolescents attending their clinics or for researchers gathering longitudinal data.

For children 0-5 years we recommend users to continue collecting the data with WHO Anthro (see www.who.int/childgrowth/software) which includes other growth indicators and motor milestones. Once the child is 61 months of age these data can be imported into WHO AnthroPlus for further monitoring. To transfer data from WHO Anthro to WHO AnthroPlus, please choose XML format.

The module also allows users to define additional data variables to be collected during each child visit. For consistency purpose users should define these variables before starting the data collection as this template will then be applicable to all children.

To open, click on the respective button on the start window or select the IA from the application menu.

4.3.1 Main window
The module's main window consists of two parts: To the left is the active list, showing some example children; to the right is the child-specific window.

Tick the box next to child's name and click on to open a child record. The child's details, parental data and list of visits appear in the window section to the right.
Menu options

Access to online help

Child window section with fields to enter the child's name, DoB, specify sex, ID and open sub windows to enter parental data as well as address information and general notes that one would like to be reminded of each time the child comes to be measured (e.g. LBW).

Active list with example children and their ID number in parentheses

Icons on top enable user to manage the list (i.e. add, open, delete, archive, search and view archive)

List of visits (1 row = 1 visit) with selected visit highlighted in blue; visit results by indicator below. Click on to open graph.

Use arrow, <Enter> key, or mouse to select other visits.

Icon functions: to add new visit ; to open a visit or double-click on selected (highlighted) row; to delete selected visit .

Notes

This field enables the user to collect child-specific data such as birth conditions, metabolic diseases, special conditions, which might be important to recollect when the child comes for an assessment. These notes are also exported and will appear for every visit.
Graphs

Click on ![maximize icon] (or corresponding icon) to maximize the graph.

To select other indicators or view percentiles use respective drop-down menus at the top.

To change display **single or multiple points** use the drop-down menu.

An explanation on top of the graph reminds users that the curves are based on WHO standards and WHO reference.

The currently open visit is marked by the red grid lines.

With the left mouse click the user can select and enlarge a part of the graph. To resize the graph to the original dimensions, click on ![resize icon].

To copy the image to clipboard, click on ![copy icon].

To send image to printer, click on ![print icon].

To close graph, click on ![close icon] or the corresponding icon in your MS version.

If a measurement cannot be plotted, the message "(No data)" appears on an otherwise blank screen. This happens when a measurement is outside the plotting range, even if the z-score is valid. It also happens when z-score is NA due to missing data or when raw data are beyond the standard tables' ranges (see section 1.3).

Copied graphs do not include titles. Thus users need to create customized titles in the word processor environment. The exis labels will help identify the indicator.

Clicking on the menu bar *Individual assessment* enables the user to activate the following functions:

- *New child*  
- *Delete selected*  
- *Archive selected*  
- *Search list*  
- *View archive*  

Icons on top of active list of children
Once a child's window has been opened the user can select from the menu bar Selected child the functions:

- **Save changes** ➔ same as ![Save](image)
- **Cancel changes** ➔ same as ![Cancel](image)
- **Generate child report** ➔ same as ![Generate](image) (see section 4.3.4)

### 4.3.2 New child

The steps to enter a new child are:

- First click on ![Add](image) at the top of the active list of children to open a blank New child window.
- In the active **New child** window enter his or her first and last name and specify sex (the ID attribution by default is set to automatic).
- Use the keyboard or drop-down calendar to enter DoB.
- Click on ![Add](image) to save and the new child's name with ID will be appear added to the list on the left section.

**Mother, Father, Address data**

Fields for data on parents and address appear to the right of the child window. These fields are optional and can also be left blank. Once completed, the fields show the parents' names with ID in parenthesis and the address information.

Each of the mother/father/address windows have separate ![Save](image) and ![Cancel](image) buttons that are not linked to the child and thus the child and parental ID numbers can be different.

It is possible to link the same parent/address data to several children. Note that free text typed into the fields without activating this function will not be saved and no ID will be assigned.

To add information, click on ![Add](image).

To edit existing information, click on ![Edit](image).

To select data from an existing record (e.g. sibling) click on ![Select](image). If there is no text entered in the box, the entire list of available data appears in alphabetical order. Entering some text before opening the drop-down list will activate a filter function.

If the user opens the father/mother/address window and saves **without entering names**, the system displays (No data). Saving the field automatically triggers the allocation of an ID for the parents (list of mothers/fathers) regardless of whether data have been entered or not. Note that the parental ID is not
linked to the one of the child.

Both the mother's and father's window include the option to enter their weight and height data; if entered the software derives the BMI (kg/m²).

To enter DoB either use the keyboard or drop down calendar. The derived age appears below.

A separate Notes field enables the user to collect additional information for each parent.

Click on next to Address to add new information and open the respective data-entry window.

Depending on what has been selected in Settings the Address window can look like one of the images below:

- No address reference data: Free text can be entered into all fields.
- SALB: In either of those two options, the Address window includes a comprehensive list of countries and territories and the user can select the appropriate one from the drop-down menu.

The address data can be useful to track a child in the future. All fields are optional and the user can complete as many or as few fields as deemed important. For example: ZIP/postal code (maximum 15 characters); Phone number (maximum 20 characters).

To activate SALB level 1 and 2 fields the user first has to upload the relevant country SALB file under Settings in the Start window (see section 4.1). Once that is done, go to the address window, select country with the drop-down menu and the SALB fields will be activated automatically. Consequently the user can select the country’s administrative levels from the drop down lists of SALB level 1 and level 2 without having to type anything.

For more information on the use of address reference data and of SALB files see section 5.1.

Delete

In the list of children, click on the tick box next to the child's name to select child and then on or select from menu Individual assessment → Delete selected. A message window will pop up where the user has to confirm that s/he wants to delete the selected child. If a child is deleted all her/his visit data will be deleted.

Note that a deleted child's record cannot be restored.
Archive

The archive function allows the user to temporarily move one or several children from the active list into the archive.

Tick the box in front of child's name to select and click on "Tick"; or select and go to menu Individual assessment → Archive selected. The selected children disappear from the active list and are moved into the archive.

To retrieve a child from the archive click on "Uncheck" or go to menu Individual assessment → View archive. Select the child(ren) and click on "Check". To return to the active list click on "Uncheck".

Note: There is no space limit in the archive, but the user should be aware that operations may take longer to perform on this file as its size increases. If children's data are no longer needed, it is better to export them and archive them outside the software.

Search

To search for a child (or several children) in the active list click on "Search" or select Individual assessment → Search list. This opens the search window.

Possible search criteria are:

- First and last name of the child
- Child's sex
- Child's ID: click on From to activate the entry fields for a range with inclusive lower upper end limits
- Date of birth: To enter a range with inclusive lower and upper date, click on From to activate the date fields

Enter one or several criteria and click <Search>.

The search for names is not case-sensitive and uses pattern-matching to give best possible search results. An asterisk "*" can be used as a wildcard if the full name is unknown, e.g. entering [L*] will find Lopez. This allows for searching for a name even if only part of it is known, e.g. searching for "a*" in first name will list both Flora and Jane; searching for "an*" will only list Jane. Similarly searching for "anz*" in family name will list only Kwanza.

The active list will show all the children that match the specified search criteria. A search can be further refined with additional search criteria. To return to the complete list click on <Clear search>, and click on "X" (or corresponding icon in your MS version) to close the Search window.

Note the search does not consider any children who have been moved into the archive.

Manage additional data

This function facilitates the systematic collection of clinical and other data. As in the design of a questionnaire, the user can define new sections and then variables within that section. Once defined these variables will apply to all children in the module. It is thus highly recommended that the user
defines first the additional data variables before starting with the data collection. At present the template contains some examples e.g. maturation, physical activity, fruit and vegetable consumption.

To open the template click Individual assessment → Manage additional data.

Click on + to add a new section. Enter ID name (mandatory) and a description (optional).

Click on + to add a new variable to a created section. Enter ID name (mandatory), a description (optional) and specify the value type: text, numeric ranges or date.

Users are advised to create all sections and variables first and only when finished click on <Save>.

To delete a variable or section select the text on the left window and click on x. If a section is deleted all variables within that section are automatically deleted. A warning message will pop up asking the user to confirm the action. The data already collected for these variables will remain in the previous visits. To avoid confusion it is recommended to clarify the desired additional data t before starting a database of individual assessment.

The current example template can be deleted or changed to suit the user's needs. Click on <Save> to close the window; click <Cancel> to discard unsaved changes and close the window.

These additional data sections and variables apply to all new child visits in the IA module; the corresponding data can be collected in the visit window (see sections 4.3.1).

The created variables and sections always appear in the language the user applied when adding them, i.e. they are not translated when the user changes the language in Settings.

Note: This function is not designed to replace a comprehensive questionnaire and it should only be used for a limited number of additional variables necessary in context of the child growth and development assessment. They increase the size of the SDF database file and reduce operational speed.

**Options: ID assignment**

To change from the default setting of automatic ID attribution to manual the user has to click on the IA menu on top and select Options.

The IA options window allows the user to change the ID assignment by clicking the respective radio button. This selection will remain active until changed again.

If manual ID assignment is the selected the user can enter any number with a maximum of 32 digits.
4.3.3 New visit

Click on in the visits section of the child window to open a new blank visit window (see image below).

- DoV is automatically set to today's date but can be changed. To change DoV use either keyboard or calendar. The calculated age in years and completed months is displayed below (see also 3.2.1).
- Enter the measurements and specify how length/height was measured if the child is < 61 months.
- Specify if the child has oedema (see 3.2.2).
- The Notes field in this window is visit-specific and allows one to record important notes relevant to this visit.
- The additional data variables as defined beforehand appear in the lower window section.
- Click on at the top left corner to view the plotted measurements of this visit. The weight-for-age graph opens by default and from this window other indicators and options can be selected from the respective drop down menus.

Note that for a child above 10 years of age no weight measurement can be plotted because the WHO reference table for that indicator stops at 120 months. In this case a blank screen appears. To open the graph of another indicator select it from the drop-down list (see 4.3.1).

- To close the graphs window, click on or corresponding icon in your MS version.
- Click on the <Save> button to save and close visit window.
- Click on <Cancel> to close the visit window without saving the entries made.
- To save changes made to the child's data file, click on at the top of the child window, or use the menu: Selected child → Save changes.
- To enter another child repeat the steps outlined above.

Note: Measurement data from previous visits can be opened and edited at any time.

To delete a child visit select the row and click on , and confirm with <Yes>. The application removes the visit from the Visits table.

To edit a previous visit, select the row and double click with the mouse or click on .

Note: Measurement data from previous visits can be opened and edited at any time. The date of a previous visit, however, cannot be changed.

To close the module, click on (or corresponding icon) or use the menu, Individual assessment → Close module.
4.3.4 Child report
The IA module enables the user to generate a child report including for all visits the basic anthropometric data and results in z-scores.

To generate the report click on \( \text{Generate child report} \) in the child window or go to the menu Selected child → Generate child report. The software will request the user to specify the location where the *.TXT file should be saved. The file will automatically open in the program assigned to read *.TXT files. The column labels are self-explanatory. The notes created on the child level, e.g. concerning birth conditions are not included in this report.

To obtain percentiles the user can go to Excel and create columns next to the z-scores and enter the formula "=NORMSDIST(select cell with z-score)". E.g. a z-score of -2.20 is converted to 0.01390, meaning the 1.4th percentile. To return to a z-score the formula needed is "=NORMSINV(select cell with percentile)".

4.3.5 Import from file
Into the IA module the user can import child visit data only from files in XML format previously created in WHO Anthro or WHO AnthroPlus. Hence if the user intends to re-import data later into AnthroPlus, s/he should choose the export format XML. Exported IA files can be carefully edited using a XML editor and then re-imported into AnthroPlus as long as the expected format remains unchanged and the specific rules are followed, see below.

Data files to be imported need to follow the specific IA file schema (see section 5.5.3). The software is programmed to check that only valid data are being imported. For example, measurement data beyond valid ranges (see 3.2.3) are not imported and cells are turned to blank.

Note: The imported measurements when mapped are truncated after 2 decimal places which is the assumed highest level of precision.

Specific rules:

- When importing children into IA, each child’s visits must be ordered chronologically. Visits going back in time will cause the imported file to be rejected.
- The first visit date must be equal or later than the date of birth.

4.3.6 Export to file
Child records that are no longer used should be exported and then deleted from the software. This will ensure that the database is not growing endlessly, and that the software functions do not slow down. The export function also allows the user to create a file for further analysis including all notes and additional data variables.

To activate the Export function select one or several children from the list by ticking the boxes in front of their names. Then open the menu Individual assessment → Export to file.

Select the folder, specify the file name under which you want to save the child data and choose the format. Child visits data in the IA module can be exported to XML, CSV and TXT formatted files. As mentioned before, if it's uncertain whether the data need to be re-imported into the software, the user should choose XML.
This pop-up window will appear next where the user has to click on <Yes> or <No>.

The exported file contains all basic data, the raw measurements including Notes, Mother, Father, Address and Additional data variables, and if selected also the results in z-scores. The software also includes the information on who created the data-entry. This information is linked to the registered logged-in user.

Note that the exported results include all calculated z-scores even if they lie beyond the flag limits. In case of further analysis users are encouraged to apply the recommended flag limits, see section 3.4.2.

When exporting files as TXT or CSV (not XML), all additional data variables will be exported in separate columns. The name of each column corresponds to the ID name of the variable, while the section ID name will be lost. Users are thus advised to create unique self-explanatory variable ID names.

When exporting the IA data as XML (which is a hierarchical file format) all additional data will appear in a single element (column). After re-importing XML files the additional variables appear again separated and the user can edit and change the data-entries.

4.4 Nutritional survey (NS)

This module facilitates:

- Collecting new nutritional data based on a sample of children (one record per child)
- Deriving and displaying individual results using z-scores and percentiles based on the WHO standards and the WHO reference depending on the child's age for the indicators weight-for-age, length/height-for-age and BMI-for-age
- Opening, editing, saving and deleting existing surveys and survey records
- Moving surveys temporarily into and retrieving them from the archive
- Deriving standardized summary results with and without 95% CIs
- Correcting the 95% CIs for surveys with cluster sample design
- Importing survey data files in *.REC, *.DBF, *.TXT, *.CSV or *.XML formats
- Exporting survey data files in *.TXT, *.CSV or *.XML formats

The NS has the following differences compared to the IA module

- A child can only have one assessment
- The user can collect data on: Cluster, Household and Team
- Survey options allow changing ID attribution, flag limits and age groupings

To open the module click on the respective button on the Start window or select it from the Application menu.

When opening the module, the column to the left shows the list of active surveys which contains one example while the right window section is grey and inactive.
4.4.1 Survey window
To open the Sample survey highlight the name with left mouse and click on icon above. The data-entry tab window to the right becomes activated and shows the sample survey's records with the first record selected (highlighted in blue) and the child record's results below the spreadsheet (similar to AC and IA modules).

To select any other record use arrow or <Enter> keys or left mouse click.

The user can click on any column header to sort the records in ascending order (alphabetically or numerically); clicking again sorts records in descending order. In case the order of records does not resemble the one shown below, click on the ID header.

Note that the date format (e.g. dd/mm/yyyy) depends on what the user selected in his/her computer settings.

Menu options Open online help page Window with child records of open survey with on top the fields to enter/edit survey Name and Notes.

Active list with sample survey; icons on top enable user to manage the surveys (e.g. add, open, delete, archive and view archive)

List of records (1 row = 1 record) with selected record highlighted in blue; respective results by indicator below. Click on to open graphs. The z-scores are also included in the spreadsheet. Scroll to the right to find the grey shaded columns.

Click icons: to add new record; to open selected record or double-click on highlighted row; to delete selected record(s); and to filter and select a sub-sample.

Results corresponding to highlighted row (similar to IA): WAZ is NA because child >10 yrs
**Name**

This field is mandatory, and the user has to fill in a specific name to the survey. If the user opens an existing survey and changes the name the new name will overwrite the old one.

**Notes**

This field enables the user to collect data that describe the survey, such as geographic location, which accounts for all records. The information included here will also be exported next to the survey name.

**Nutritional survey**

Clicking on the menu *Nutritional survey* enables the user to activate the following functions:

- **New survey**
- **Delete selected**
- **Archive selected**
- **View archive**
- **Import from file**
- **Export to file**
- **Close module**

**Current survey**

Once a survey has been opened the user can select from the menu bar *Current survey* the functions related to the open survey:

- **Save changes**
- **Cancel changes**
- **Survey options**
- **Manage additional data**
- **Copy records to clipboard**
- **Standard report with CIs (Excel)**
- **Estimates without CIs (Excel)**

The results in z-scores and percentiles below the open survey records refer to the selected (highlighted) child record.

The following icons and corresponding functions are available on top of the records list:

- **+**
- **-**
- **Edit**
- **Copy**
- **Word**
- **Excel**
- **Excel**

Click on **+** to add a new record

Click on **-** to open a selected child record
Click on × to delete one or several selected child records

Click on ✔ to open Filter records window which enables users to select a sub-sample

**Manage additional data**

This function is similar to IA (see details in section 4.3.2). Every new user-defined variable is added as a new column to the right of the spreadsheet.

Note that only for new children added will this variable be available for data collection. Thus, ideally the additional variables should be defined before data collection starts.

To add additional data variables go to Current survey → Manage additional data and create sections and variables as outlined in 4.3.2.

As in the IA, the created variables and sections always appear in the language the user applied when adding them, i.e. they are not translated if the language is changed in Settings.

When an existing survey data file (e.g. *.REC or *.DBF) is imported into AnthroPlus, the additional data variables (e.g. hemoglobin, dehydration, etc.) are retained as such. The user can continue collecting this information in the AnthroPlus environment and also edit existing records. Users are advised though to limit the additional data variables as these increase the software's database size and thus slow down its functioning.

If the user deletes a variable, it is automatically deleted from the spreadsheet and the column disappears permanently. Changing the additional data template half way through a survey will only affect the records created after the change. Existing records are left with their existing additional data structure. Exported records will always show the columns of the additional data variables as defined in the template. If this information has not been collected for some records the corresponding cells will be blank.

In the exported file formats CSV and TXT the additional variables are presented in separate columns to facilitate further analysis. To ensure that there is no confusion users are reminded to label the variables with unique names. In case a name is repeated the software will append a number to avoid duplicates, e.g. Sport, Sport2 etc. in the exported data. If there is more than one variable with the same section ID and variable ID, the values for the duplicate variables will be lost when exporting (as they are indistinguishable the retained value is always that of the first variable matching the section ID/variable ID combination).

Note that XML is now the only format keeping all data strictly intact (TXT/CSV files lose additional data structure as described).

Best practice is to export a survey data set after analysis and when it is no longer used. Once archiving outside the software is completed, delete the survey from the software in order to keep the database file as small as possible.

As a guidance, below are the sizes occupied on disk by a survey with more than 10'000 records including additional data variables:

- Original DBF file ~2.5 MB
- Exported as TXT ~1 MB
- Exported as XML ~9 MB
- Size in SDF database ~35 MB

Note that the software's database *.SDF file can be as large as 2 GB.
4.4.2 New record

Clicking on opens a data-entry window similar to the one in the IA module.

The new fields are:

Age in months if DoB is not available; in that case tick the box next to "Unknown date" under DoB and then enter age in months into the Age (m) field.

Cluster, Team, ID and Household (automatic or manual depending on selection in Survey options) with maximum 10 digits

Weighting factor (default set to 1.00, maximum with 16 decimals)

All measurements can be entered with precision up to 2 decimals.

Click on to open the graph window.

The graph’s zoom-in function works as in the AC and IA modules. To reset to original dimensions, click on .

The Notes field is record-specific and enables the user to collect information that may be important in relation to the interpretation of the visit results (e.g. child was restless, very sick, needs referral, etc.)

To edit an existing record select row and click on . Click on the <Save> or <Cancel> button to return to list of records.

To delete a record, select first one or several records (CTRL + click, or SHIFT + click) and then click on . User is prompted to confirm the wish to delete. Once deleted the records cannot be recovered.

4.4.3 A special note on age

When the user has entered DoV and DoB, the age is automatically derived in years and completed months for the calculation of the z-scores (depending on whether the WHO standards or the WHO reference are used). Age in days and in months are then reported in separate columns on the spreadsheet.

There are several scenarios for deriving the age information:

1) If the exact birth day is not known the user should probe the caregiver to obtain at least month and year of birth and then tick the box next to Approximate date. A randomization process will select a day within the given month and complete the DoB. In this case the randomly derived DoB is used but on the column in the spreadsheet the day of birth is displayed as "XX" to make up a DoB that reads something like XX/mm/yyyy. In the export process the derived date is exported in full (without "XX") and the column ApproxDateOfBirth is set =1. Alternatively some researchers may prefer to enter consistently the middle of the month as the day of birth (dd=15).
2) If the caregiver remembers only the child’s age in months, enter that information into the field at the top right of the New record window. If the age is less than 61 months the software derives age in days (see 3.2.1); if the age is 61 months and older this information in completed months is used to refer to WHO reference tables.

3) If the user wants to import a survey data set with only age in years s/he has first to create a new variable, e.g. “agemons” and convert the years into months by multiplying the number of years by 12. If on the other hand, age was measured in days, users are advised to first create a new variable (e.g agemons = agedays/30.4375) before using the import panel “Age (in month)” option.

The converted age information in months is displayed as an un-rounded value with two decimal places on the spreadsheet, while age in days appears as whole number. To classify the results into age groups the completed months are used and not age in days.

In the NS module, if age cannot be derived because of missing dates only a BMI value will be calculated and the child will thus not contribute to any prevalence calculations.

4.4.4 Survey options

To open Options window click on or select the respective function from the Current survey menu. The user can change the ID attribution (if ticked automatic), z-score flag limits and age groupings.

The flag limits can be changed using the scroll bars or with the key board. Any flag changes affect the analysis results. They thus have to be documented and reported together with the prevalence results.

The default setting is to have automatic child and household ID assignment, while IDs are assigned manually for the variables Cluster and Team.

The default age groupings are as shown in the lower part of the window.

Lower and upper limits are inclusive.

Changes should be made to the lower limit (the upper adjust automatically) - the only exception being the upper end of 228 months.

Click the <Reset> button to restore the default settings.

If not all age groups exist in the data set the corresponding rows in the report will be empty.
4.4.5 Flagging

According to the set flag limits, the software flags out in purple on the spreadsheet any extreme, potentially incorrect or out-of-range values (see section 3.4.2). As mentioned above, the default flag limits can be changed in the Options window.

Note that on the selected row due to the dark blue background the colour purple is difficult to see.

If z-scores appear as flagged the user is advised to check for potential data-entry errors (age, weight, length/height) and, if possible, to correct the data before proceeding. After editing a file or altering the flag limits, the user is advised to save the file. All flagged z-scores (highlighted in purple) will be excluded from the analysis.

Missing z-score values appear as blank cells and are taken into consideration in assigning flag codes (see below).

Flag codes
In the FLAG column adjacent to the z-scores the software displays a record-specific flag.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Error tracking</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>Valid z-scores were derived for all indicators.</td>
</tr>
<tr>
<td>HAZ</td>
<td>This could be an extremely short or tall child, or length/height data missing. If missing the HAZ and BAZ cells are empty. It is recommended to double check the height data to assure that it is correct and consistent on the data collection form and the computer file. Alternatively, the age could be incorrect or missing; therefore one should look at the WAZ value to see if it is extreme as well or blank.</td>
</tr>
<tr>
<td>WAZ</td>
<td>Either weight or age may be incorrect or missing.</td>
</tr>
<tr>
<td>HAZ &amp; WAZ</td>
<td>Age information may be incorrect, out of range or missing.</td>
</tr>
<tr>
<td>BAZ</td>
<td>This may indicate an unusual combination of WAZ and HAZ.</td>
</tr>
</tbody>
</table>

4.4.6 Special spreadsheet functions

Move, sort and filter child records

Besides the scrollbars, there are the following keyboard shortcuts to move easily through the list of records:

- **CTRL + ↑** = go to top of list
- **CTRL + ↓** = go to bottom of list
- **CTRL + →** = go to the right of list
- **CTRL + ←** = go to the left of list
The columns with the calculated z-scores in the spreadsheet are grey-shaded to easily distinguish them from the rest.

To sort the survey records by any variable click on the header cell. Whether the result is in ascending or descending order can be seen by the added symbol, i.e. ▲ = ascending, ▼ = descending. For text variables, sorting in descending order auto-resizes the column width to display all the characters.

Filter function

By clicking on the iterative filter function the user can select a sub-sample of the current survey for further analysis.

Select a variable from the drop-down menu under Field; specify Condition and complete Value field.

To obtain the selected sub-sample click <Apply>; or <Cancel> to undo the filter selection. This filter function can be applied stepwise, i.e. first select males, then a certain age range, etc.

When a filter has been applied a new icon is added and the number of records re-counted (see image to the right using the sample survey and the filter sex = male).

Clicking on clears the filter and returns to the complete list of survey records.

The filter function can be used to obtain a sub-sample for further analysis in case estimates are required by another stratifying variable; similarly the user can quickly view e.g. all children with WAZ<-2 SD.

Copy to clipboard

The user has the option to copy all or part of the survey records to a clipboard and paste them into another spreadsheet program, e.g. Excel. To select the rows either point the cursor, click and drag over the number of lines to copy, or use keys <SHIFT + ↓> (down cursor). To select multiple single lines, <CTRL + left mouse click> on each of the rows to be copied. Click on in the survey menu bar and the selected rows are always copied automatically with the column headings.

4.4.7 Results

The Results tab window can be opened when a survey has at least 12 records. It allows the user to visually check the distribution of survey data for outliers.
The first graph shows the shift of the surveyed population's weight-for-age compared to the normal distribution. From the drop-down menu the user can select other indicators and further graphical overviews, i.e. by sex, cluster and age.

On this tab section the user can choose to display the z-score distributions by indicator for the survey data compared to the normal distribution curve. To select another indicator click on the drop down menu.

Note that the displayed graphs are based on the standard analysis, i.e. using all available valid z-scores lying within the chosen flag limits for the graphed indicator. This option may result in different sample sizes by indicator. In case the survey contains sample weights, the sample size given is the weighted N. The formula used to produce the distribution graph is based on Kernel smoothing (Fox J, 1990).

If a distribution looks unusual or indicates the inclusion of outliers, the user may want to return to the spreadsheet and edit the raw data. If no (more) anomalies are identified the user may proceed to run the survey analysis.

To change the age groupings and flag limits click on , or open the menu Current survey → Options.

Weighted N is derived using the sample weight in the sample survey. If no sample weights are entered the programme attributes the weight 1.0 and unweighted and weighted N are identical.

Analysis and report options

The user can choose several analysis report options. S/he can select them either from the menu Current survey or by clicking on respective icons. When sampling weights are available the full precision is used (maximum 16 decimal points) even though in the spreadsheet they appear truncated.

The report options are:

Standard report (): Under this option the user can further specify if a correction for clustering needs to be applied in case of a cluster sample design. The Standard analysis makes maximum use of the
collected data and includes for each indicator all valid z-scores. With or without correcting for cluster sampling, the outputs show prevalence by age groups and totals, stratified by sex for the common cut-offs, with means and SDs of z-scores, and 95% confidence intervals.

The differences are:

- When choosing standard analysis corrected for cluster sampling, the formula to derive the 95% CIs is changed to correct for this specific sampling method; the resulting CIs are slightly wider than without this correction. Beforehand the user has to have loaded the cluster identification variable into the corresponding "Cluster" field.

- When choosing the standard analysis without the correction for cluster sampling, the 95% CIs are derived for a survey based on a random sample; and in this case the survey analysis can produce stratified results for any variable e.g. "Area (urban/rural)" that has been mapped into the AnthroPlus field "Cluster".

The age-stratified results follow the age grouping defined in Options (see 4.4.4). Due to the inclusion of all valid z-scores, the sample sizes per indicator in the result tables may differ. Child records with missing age do not contribute and are excluded from any analysis.

Given that children with oedema should not be weighed because of their flawed weight, no individual WAZ or BAZ can be derived. Therefore these children do not contribute to the respective mean and standard deviation statistics in the analysis report. However, oedema cases are included as severely malnourished children in the prevalences of <-3 SD (and <-2 SD) weight-for-age and BMI-for-age. A child with oedema and unknown age contributes to the overall sample size and prevalence of low weight-for-age, and low BMI-for-age, i.e. %<-3 SD and %<-2 SD. However, s/he will not be considered for the age disaggregated sample sizes and prevalences. The number of total oedema cases in the survey is reported in a footnote of the table.

Estimates report: This option produces an analysis output following a standard data-entry format without 95% CIs. The analysis also uses all valid z-scores to make full use of the available data in the survey, similar to the Standard report. The sample sizes pertaining to the weight-for-age indicator are used as the overall and disaggregated N for reporting purposes in this report. Given that this report does not include the CIs, the correction for cluster sampling is irrelevant and the user does not have to make a choice.

Children with oedema or missing age are treated in this analysis option in the same way as for the Standard analysis (see above).

4.4.8 Data import
Data can be imported into the NS module from files in CSV, TXT, DBF, REC (EpiInfo) and XML (previously created in WHO Anthro or AnthroPlus) formats.

Before importing data sets it is recommended to ensure that there is a unique identifier field. In importing ensure to map the corresponding variable with the AnthroPlus field ID. This facilitates merging of records in case of later export.

Variables in the original data file with names labelled "WAZ", "HAZ", "BAZ" (e.g. z-scores based on the former NCHS reference) should be renamed before importing to avoid confusion. If there remain any similar variables the software will add the number "2" to the name.

Files coming from WHO Anthro, including children 61 months and older, are best imported in XML format. AnthroPlus recognizes the origin and if needed automatically converts the age in days into age in months. In case of WHO Anthro exported files in TXT and CSV format that have no DoB and DoV variable but only age in days, the user needs to convert the age in days into months before importing into AnthroPlus. The conversion is to derive age in months by dividing age in days by 30.4375.
For any data file with only age in years [ageyrs] and no DoV nor DoB, users have first to create a new variable for age in months (e.g agemons = ageyrs × 12) before importing into AnthroPlus. It is recommended to round age in months to 4 decimals.

From Excel it is best to save a file as TXT (tab-separated) and import into AnthroPlus. CSV files need to have semi colons as separators to be accepted into AnthroPlus. Semi colons were chosen as they are rarer in the data sets, thus minimizing potential errors with badly formatted files. To change the separator from comma to colon go to the Control Panel → Regional and Language Options. Open → Customize and specify value for field List separator.

To import files in TXT, CSV, REC (EpiInfo data files) and DBF format, the user has to map all basic AnthroPlus fields with the variable in the original file (see image).

To map variables click on the drop-down menu button for each and select its match from the list. If there is no match leave it blank.

Imported weight and height measurements are truncated after 2 decimal places.

To enable the programme to produce stratified results by another variable than age and sex the user can load this variable in the AnthroPlus field "Cluster", which has to be an integer. For example, the variable "Area" in the data set with coding 1=urban, 2= rural.

If DoV, DoB and age in months are imported together, the age is derived using DoV-DoB as these data take precedence over the imported age in months.

Variables that require specific formats are:
- Cluster, Team, ID and Household: numeric integer value
- Sex: numeric value with 1= male and 2= female
- Age in months: numeric values with max. 5 decimals
- Weight: numeric value (in kg) with max. 2 decimals
- Height: numeric value (in cm) with max. 2 decimals
- Oedema: text variable with y=yes and n=no
- Sampling weight: numeric value with max. 16 decimals

Notes on import:
Surveys with the same name are imported independently. Nevertheless to avoid confusion it is best to give unique names to each survey.
Cluster survey data should have the clustering variable as integer values.

It is highly recommended to include in the import a unique identifier variable and map that into the AnthroPlus ID variable.

Records with missing or invalid mandatory data, e.g. sex = 5 (as opposed to 1=male, 2=female), will be dropped from the import and a warning message will appear.

Missing values in Survey date, Date of birth, Age (m), Weight and Height will appear as blank cells.

If survey data have no sampling weight the software attributes a sampling weight=1 (Wt factor). If a child record should be excluded from the analysis, the user is advised to insert "0" into the record's Weighting factor field. When the 'weighting factor' field is mapped on the import dialog, then every missing (empty), out-of-range (i.e. negative) or other invalid sampling weight in the imported records will also be set to "0" and in a weighted analysis such records will be ignored.

The following message appears when for example an AnthroPlus field e.g. Cluster, Team, Household which expect integer values is mapped with a text field, e.g. urban/rural or regions.

In case the value is not needed for later disaggregation in the analysis the user can simply continue by clicking <OK>. If the variable is needed for producing stratified results, any text variable has to be converted into numeric integer values before mapping in the import process to the AnthroPlus field "Cluster".

After the import the software highlights in purple any extreme or potentially wrong z-scores in the grey-shaded results columns (see section 3.4.2). This way the user can scroll through the file and check the data.

Where age appears as 24 months (= 730.5 days) in imported *.WNS (old file format of WHO Anthro), *.REC and *.DBF files, age is rounded to 731 days before deriving age-based estimates for children less than 61 months.

Additional variables are imported and appear to the right end of the spreadsheet.

**Good practice**

If a data file contains many variables, it is recommended to import into WHO AnthroPlus only the relevant data variables needed for deriving z-scores and then export the data back and merge with the original file. For that purpose it is important to include in the imported file a variable that defines a unique ID for each record.
Always keep a copy of the original raw data as a backup.

Once no longer needed in WHO AnthroPlus export the file and delete from the module.

### 4.4.9 Data export

In case the user is interested to run the survey analysis using another software, s/he may:

1) Select the desired rows on the spreadsheet and click to copy to clipboard. When pasting the rows into another programme, e.g. Excel, the header row is automatically copied over as well.

2) Save the survey and then export it, including results, to *.CSV, *.TXT or *.XML format.

The second is the preferred option as it ensures that all records are exported and no information accidentally missed.

The exported additional data variable will match the variables defined in the survey’s additional data template (any variables present in records but not in the template will not be exported).

Given that different surveys may have different additional data variables it is not possible to export several surveys in TXT or CSV format. In this case the following pop-up message appears:

Note that the first selected survey refers to the survey that is first on the active list

Exporting several surveys and appending them will thus only be possible in XML format.

AnthroPlus generates several variables in exported files (see 5.5.4). An example is "DateOfBirthIsApprox" which is placed in a column next to DoB. This variable is coded "1" if DoB was approximated and "0" otherwise. The estimated DoB will be exported in full.

When including in the export the resulting z-scores, the flag column is not retained in the exported NS files and the user has to redefine and apply the flag limits (see 3.4.2) for further analysis.

Note that the codes for sex in the exported file are: female =0 and male =1.
5. Other functions

5.1 Address reference data

The IA module facilitates the collection of detailed address data for each child. This information can help to trace the child for follow-up investigation.

As a first step the user has to specify in the Settings how s/he wants to collect the address information (see section 4.1).

In the Address reference data section the user can choose to not use the reference data (default setting), to use the Second Administrative Level Boundaries (SALB) datasets, or to apply user-defined country, state, province and district lists.

A comprehensive Country list, including territories and areas, comes with the installation. From this list the user can select a country/territory from the drop-down menu.

If the user chooses to not use any reference data s/he can type in freely whatever information s/he deems important into the IA address window.

To use the SALB data file the user has to prepare and upload one file per country.

To tailor lists for province, state and district to match the covered area, follow instructions in 5.1.3.

5.1.1 Country list

The Country list comes with ISO ALPHA-3 letter codes (not displayed) which are based on the United Nations Standard Country or Area Codes for statistical use found at: http://unstats.un.org/unsd/methods/m49/m49.htm.

In order to reset and replace this list click on \( \) and then \( \) to import the revised file. It is important when replacing or changing the country list to maintain its file structure, i.e. 1st column ISO ALPHA-3 code and 2nd column country name. Empty fields are not allowed.

5.1.2 SALB data

The SALB data are boundary files that are provided for the first and the second administrative sub-national level of a country. These datasets form part of the UN geographic database and can be downloaded from http://www.who.int/whosis/database/gis/salb/salb_home.htm (registration is free). Predefined SALB lists are available for most countries. SALB files facilitate the address data collection as users can select e.g. state and province names from the drop-down menu and do not have to type anything (no risk of typing errors). The advantages are that these files are up-to-date, enable the user to perform stratified analysis and mapping of results according to the country's administrative structure.

Note that the definitions of SALB levels 1 and 2 depend on the internal structure and size of the country i.e. in Switzerland these levels have a different meaning than they do in Brazil (for further information, see http://www.who.int/whosis/database/gis/salb/salb_home.htm).

When selecting SALB, the user has to specify the country where s/he will collect the data and then import the respective SALB data file.

To add or update a country's SALB file, the user has to download and convert the SALB Excel file to a tab delimited text file before uploading it to the PC.
The steps to prepare the SALB files are as follows:

After registering click on "Codes and historic changes download", which opens the URL page:
http://www.who.int/whosis/database/gis/salb/salb_coding.htm#DATA%20DOWNLOAD.

- Select the country and year version of the SALB file to be imported, download and save
- Open the file in Excel and select the worksheet with
- Delete all header and footer rows so that the file contains only the following columns: 1st administrative level names, 1st administrative level codes, 2nd administrative level names and 2nd administrative level codes.
- In Excel go to < File > Save As> and select: "Text (tab delimited) (*.TXT)"
- In case the Excel file has multiple sheets the following warning message may appear:
  
  ![Warning Message]

  - Select <OK>
  - The following message will be displayed:

  ![Warning Message]

  - Select <Yes>
  - Copy the created file to a predefined folder for the address data.
  - Open Settings from the Main window and click on to the right of SALB data. Select the file and click <Open> or simply double click on the file.

Countries with SALB data for only the first administrative level (e.g. Andorra, Botswana, Jamaica, Liechtenstein etc.) need further preparation: Once the TXT file has been created, open in EXCEL and add a 3rd column with the text "Area without administration at 2nd level" and in the 4th column enter the same code as in corresponding column 2, adding "XXX" before saving as TXT (tab delimited).

Even when SALB data collection has been specified in Settings, the user can still collect other address information, i.e. postal code, phone number, e-mail, etc.

When exporting IA records with SALB data, the location names are converted to their numeric codes as seen in the imported TXT files.

**Removing SALB data**

To remove SALB data files go to Settings:

- Click on to reset SALB data.
• Click on <Yes> to confirm and then <Save>

Note: When reset is activated, all currently imported SALB files will be deleted.

5.1.3 State, Province and District list
State, province and district lists can be tailored to meet user-specific needs and facilitate the collection of address information according to specific administrative or geographical settings, e.g. local administrative structures and codes. This is also helpful for the collection of address data in countries that do not yet have SALB data.

In Settings the user can specify which lists to use and upload those for use in the IA module.

To construct these *.TXT files follow the formats outlined in section 5.5.3.

Rules for importing address reference data
When a given item (e.g. country) appears more than once in the imported file, the first occurrence is taken into account and subsequent ones are ignored. Items are identified by their ID fields, i.e. ISO-3 code for countries, level 1 or level 2 code for SALB data (this rule does not apply to states, provinces and districts as they only have one field).

Imported SALB files can only contain data for one country (i.e. SALB data for more than one country must be loaded from distinct files).

Deleting address reference data
Countries can only be deleted if they are not referenced by SALB data. This means that SALB data must be deleted first if necessary.

5.2 Online help
In case the user does not have the manual available, contextual online help pages provide instantaneous, concise guidance on key module functions. To open any help page with a module click on Help on the menu bar. To close a help page, click on the icon at the top right corner. These online help pages are only available in English and are intentionally kept short.

5.3 About
To open the About window go to Start window and click on Help → About. This window presents the software's objective, contact details and links to the web sites of the WHO reference 2007 and the WHO child growth standards.

5.4 Error log and error reporting
A log function documents any major errors in the Log.XML file which is located in the application folder.

Even though exhaustive testing was performed to ensure that this software works properly, virtually all software programmes have "bugs". It would thus be appreciated if users could send a brief report on any encountered problems (random or systematic) when using WHO AnthroPlus.

Please send a bug-report describing in detail:

• The problem found
• Whether the problem appeared systematically or randomly
• Where exactly and in what module interface it occurred
• How it occurred, including what sequence of commands and/or buttons led to it
• What the expected result had been
• If you managed to circumvent/solve the problem, how you did that
Additionally users can use screenshots and include a copy the log file when sending the bug report to
the following address:

WHO AnthroPlus
Department of Nutrition
World Health Organization
Avenue Appia 20
CH - 1211 Geneva 27

fax: +44 22 791 4156

who_anthro@who.int (add "AnthroPlus" in the subject line)

Please note: This is not a helpline address.

5.5 File formats

5.5.1 General rules
All imported or exported files must follow the rules below:

- File encoding must be Unicode UTF-8 (which includes ASCII).
- Within files, new lines must be encoded by carriage return/line feed (CR/LF) character pairs
  (Windows standard).
- When importing: If the imported file contains any invalid data, the whole file is considered
  invalid – the file is rejected and no data are imported.

About *.TXT, *.CSV and *.XML files (concerning data exchange)
- For data that include ‘change tracking’ fields (i.e. CreatedBy, LastUpdatedBy and
  LastUpdatedAt):
  o import/export files only include CreatedBy.
  o when importing, LastUpdatedBy and LastUpdatedAt will be set to the current user’s
    name and current date/time, respectively.
- Exported files can include the calculated values (anthropometric indicators + BMI).

About ASCII (*.TXT or *.CSV) files specifically:
- These text files will hold all data in a flat format.
- *.TXT and *.CSV files only differ by the character used to separate fields:
  o *.TXT files use a tab (Unicode 9)
  o *.CSV files use a semicolon (Unicode 59). The format specifications below use
    semicolons to delimitate fields.
- The order of the fields is fixed and follows the format defined in the following sections.
- The first line in each file contains the field header names, but its purpose is purely informative
  in the context of the WHO AnthroPlus applications: when importing, the first line’s content will
  be ignored.

5.5.2 File formats

Field types
The text format use for Datetime fields is: yyyy-MM-dd [HH:mm:ss] e.g. 2007-04-16, or 2007-04-16
16:52:31

Symbols
The following symbol conventions are used when describing text file formats (*.TXT, *.CSV and
address reference data):
¶ = CR/LF
¬ = tab
[##] = character with hexadecimal value ##
<x> = value for field ‘x’
5.5.3 IA data format

Exported TXT or CSV files
Each line – except the first – represents one visit, including all data for the corresponding child (with mother, father and address information). Ambiguous field names are prefixed with the type of the object they belong to (e.g. Mother, Father, Address…); in the absence of a prefix, fields are assumed to belong to the object represented by the lines in the file (visit).

First line (field headers) when including results
DisplayID;FirstName;LastName;DateOfBirth;DateOfBirthIsApprox;Sex;ChildNotes;ChildCreatedBy;MotherFirstName;MotherLastName;MotherHeight;MotherWeight;MotherDateOfBirth;MotherDateOfBirthIsApprox;MotherNotes;MotherCreatedBy;FatherFirstName;FatherLastName;FatherHeight;FatherWeight;FatherDateOfBirth;FatherDateOfBirthIsApprox;FatherNotes;FatherCreatedBy;AddressStreetInfo;AddressPlace;AddressZIP;AddressDistrict;AddressProvince;AddressState;AddressCountry;AddressSALBLevel1;AddressSALBLevel2;AddressPhoneNumber;AddressEmail;AddressCreatedBy;Date;Weight;Height;IsRecumbent;HasOedema;Notes;CreatedBy;WAZ;HAZ;BAZ;BMI; and [Additional data variables]

Note that Additional data variables will be exported in separate columns, at the in brackets indicated position, with the number of columns depending on the number of variables created using the menu Current survey → Manage additional data.

Other lines (visit data)
<DisplayID>;<FirstName>;<LastName>;<DateOfBirth>;<DateOfBirthIsApprox>;<Sex>;<ChildNotes>;<ChildCreatedBy>;<MotherFirstName>;<MotherLastName>;<MotherHeight>;<MotherWeight>;<MotherDateOfBirth>;<MotherDateOfBirthIsApprox>;<MotherNotes>;<MotherCreatedBy>;<FatherFirstName>;<FatherLastName>;<FatherHeight>;<FatherWeight>;<FatherDateOfBirth>;<FatherDateOfBirthIsApprox>;<FatherNotes>;<FatherCreatedBy>;<AddressStreetInfo>;<AddressPlace>;<AddressZIP>;<AddressDistrict>;<AddressProvince>;<AddressState>;<AddressCountry>;<AddressSALBLevel1>;<AddressSALBLevel2>;<AddressPhoneNumber>;<AddressEmail>;<AddressCreatedBy>;<Date>;<Weight>;<Height>;<IsRecumbent>;<HasOedema>;<Notes>;<CreatedBy>;<WAZ>;<HAZ>;<BAZ>;<BMI> and [Additional data variables]

When the user chooses not to export results, then WAZ, HAZ, BAZ, BMI are not included; and the number of additional data variables depends on what the user has defined.

Extensible markup language (*.XML) files
For IA *.xml files must follow the self-describing format outlined below (example with empty fields):

```xml
<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<Children>
  <Child DisplayID="" FirstName="" LastName="" DateOfBirth="">
    <Mother FirstName="" LastName="" Height="" Weight="" DateOfBirth="">
      <Father FirstName="" LastName="" Height="" Weight="" DateOfBirth="">
        <Address StreetInfo="" Place="" ZIP="" District="" Province="" State="" Country="" SALBLevel1="" SALBLevel2="" PhoneNumbers="" Email="" CreatedBy="" />
      </Father>
    </Mother>
  </Child>
</Children>
<Visits>
  <Visit Date="" Weight="" Height="" IsRecumbent="" HasOedema="" Notes="" AdditionalData="" CreatedBy="" WAZ="" HAZ="" BAZ="" BMI="" />
  <Visit .../>
```
Note that additional data variables in the XML format will be exported as one object but when re-importing the XML file AnthroPlus will separate them again so that additional data can be edited and saved again.

When the user chooses not to export results, then WAZ;HAZ;BAZ;BMI; are not included.

5.5.4 NS data format

Exported TXT or CSV files

Each line – except the first – in a *.TXT or *.CSV file represents one survey record, including all data for the corresponding survey.

Ambiguous field names are prefixed with the type of the object they belong to (e.g. Survey); in the absence of a prefix, fields are assumed to belong to the object represented by the lines in the file (Record).

First line (field headers)

| Date;Cluster;Team;DisplayID;Household;WeightingFactor;FirstName;LastName;DateOfBirth;DateOfBirthIsApprox;Age;Sex;Weight;Height;IsRecumbent;HasOedema;Notes;CreatedBy;WAZ;HAZ;BAZ;BMI; and [Additional data variables] |

Other lines (survey record data)

<SurveyName>;<SurveyNotes>;<AdditionalDataDef>;<SurveyOptions>;<SurveyCreatedBy>;<Date>;<Cluster>;<Team>;<DisplayID>;<Household>;<WeightingFactor>;<FirstName>;<LastName>;<DateOfBirth>;<DateOfBirthIsApprox>;<Age>;<Sex>;<Weight>;<Height>;<IsRecumbent>;<HasOedema>;<Notes>;<CreatedBy>;<WAZ>;<HAZ>;<BAZ>;<BMI> and < [Additional data variables]>; ¶

Note that additional data variables will be exported in separate columns, at the position indicated in brackets, with the number of columns depending on the number of variables created using the menu Current survey ➔ Manage additional data.

Extensible markup language (*.XML) files

For NS *.xml files must follow the following, self-describing format (example with empty fields):

<?xml version="1.0" encoding="utf-8" standalone="yes"?>
<Survey>
  <Survey Name="" Notes="" AdditionalDataDef="" Options="" CreatedBy=""/>
  <Records>
    <Record Date="" Cluster="" Team="" DisplayID="" Household="" WeightingFactor="" FirstName="" LastName="" DateOfBirth="" DateOfBirthIsApprox="" Age="" Sex="" Weight="" Height="" IsRecumbent="" HasOedema="" Notes="" AdditionalData="" CreatedBy="" WAZ="" HAZ="" BAZ="" BMI="" />
    <Record .../>
  </Records>
</Survey>
Note that additional data variables in the XML format will be exported as one object but when re-importing the XML file AnthroPlus will separate them so that additional data can be edited and saved again.

### 5.5.5 Address reference data

To load or update new address reference data in the *Settings*, the files have to follow a certain structure:

**Countries**
All lines in the file used for loading/updating countries should follow the format:

```xml
<ISO3Code>¬<Name>¶
```

*Note: No empty fields allowed.*

**SALB**
All lines in the SALB file should follow the format:

```xml
<Level1Name>¬<Level1Code>¬<Level2Name>¬<Level2Code>¶
```

This format makes it easy to generate files by copying/pasting relevant data from the SALB Excel sheets (see SALB website [http://www.who.int/whosis/database/gis/salb/salb_home.htm](http://www.who.int/whosis/database/gis/salb/salb_home.htm)) into any text editor (e.g. Notepad).

**Field descriptions**

- Level1Name, Level2Name: Nvarchar(50)
- Level1Code: Nvarchar(6), format as described in the SALB Code Scheme document.
- Level2Code: Nvarchar(9), unique, format as described in the SALB Code Scheme document.

*Note: No empty fields allowed.*

**States**
All lines in the file used for loading/updating states should follow this format:

```xml
{Name}¶
```

*Note: No empty fields allowed.*

**Provinces**
All lines in the file used for loading/updating provinces should follow this format:

```xml
{Name}¶
```

*Note: No empty fields allowed.*

**Districts**
All lines in the file used for loading/updating districts should follow this format:

```xml
{Name}¶
```

*Note: No empty fields allowed.*
6. References


